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Overview

Filefind§ is a Microsoft Windows based tool designed help you locate and manipulate 
files on your hard-drive or network drives.

To use Filefind§, enter a file specification using conventional DOS wildcards, select a 
disk drive from a scrollable list, and let Filefind§ locate all matching files on the drive.

Alternately, you can select one or more directories from the current directory tree and list 
all the files (or all files matching the current search criteria) in the directories.

Once Filefind§ finds all matching files, you may perform a variety of pre-defined or user 
defined functions.

Filefind§ allows you to select one file, multiple files, a range of files, or combine multiple
and range selection operations.  Once you have selected a list of files, you can print them,
delete them, copy them to a specified drive and directory, or move them to a specified 
drive and directory.

Filefind§ will also allow you to run a selected file if it is a file that Windows recognizes 
as a program or if it has an association in the WIN.INI file (e.g. *.TXT files are 
associated with NOTEPAD.EXE in the WIN.INI file).  Additionally, you can specify up 
to seven of your own menu items to run a specified program that will receive the selected 
file as a run parameter.
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Notations

The following notations are used in this manual:

[text] is used to identify optional information.  If the option is not specified, the 
default action will be taken. An exception is in the discussion of the 
WIN.INI file.  WIN.INI section headers are identified as [text].  These 
sections are boldfaced to assist in their identification whereas [options] are
not normally boldfaced.  Hopefully, context and the use of boldfacing will 
distinguish these two uses.

<key><character>
designate the enter (or return) key.  It also is used to avoid ambiguity in 
the documentation by specifying <character>.   For example <space> may 
be used to indicate that a space is required in some text.

bold is used for several contexts as explained in the appropriate sections.  
Additionally, it is used to identify section headings.

Italics is used to identify menus and menu items.

System Requirements

Filefind§ runs within the Microsoft Windows.  Minimum System requirements include:

Microsoft Windows 3.X or higher

DOS 3.X or higher

Approximately 75K memory*

Approximately 60K disk space

Windows compatible mouse

* Memory available within the Windows environment.  The memory required by
Filefind§ varies with use.  The minimum memory is approximately 75K and 
maximum is approximately 120K.

___________________________________________________________________________________________
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Installation

Filefind§ is easy to install. Simply copy all distribution files to the disk/directory where 
you want to run Filefind§ from.  This will usually be \windows or \win386.  

All configuration options reside in your WIN.INI file.  Most of these can be set within
Filefind§.  See the Options menu for more information.

One configuration option that can not be set within Filefind§ is the set of user defined 
menu items.  User defined menu items are used to define other programs that you want to
operate on files that Filefind§ finds.  For example, you can have a menu item that invokes
Windows' NOTEPAD program to edit a file that Filefind§ finds.  These menu items must 
be set by editing the WIN.INI file directly.  The easiest way to set these up is to first 
invoke Filefind§ and set your default options.  This will create a Filefind§ section of 
WIN.INI where you can insert user defined menu items.

To change your WIN.INI, invoke NOTEPAD (or other text editor of your choice).  Scroll
through the file until you find:

[SRS File Finder]

You may insert user defined Run menu items after this line and before the next section
(identified by [text]) or the end of the file if Filefind§ is the last WIN.INI section. Each

user defined Run menu item must be in the following format:

Runx=menutext <space> [drive:][path]program_name

Where:

Runx is the menu item identifier. Replace the letter x with a single digit, 
2 through 9.  Thus the acceptable values are Run2, Run3, Run4, ... 
Run9.  The menu items will appear in ascending numeric order.  
You do not have use consecutive items.  For example you can 
define Run2, Run5, and Run8 only.

menutext is the text that will appear in the windows menu.  You may not use 
spaces.  You may specify accelerator keys by placing an ampersand
(&) in front of the key that is to become the accelerator.

[drive:] is a DOS drive.  It may be a network, virtual, floppy, hard drive, 
etc.

[path] is a standard DOS path identification.  This parameter is optional.  
If you do not specify a path, the program must exist in the current 
directory or available from the PATH environment.

program_name
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ends with .EXE, .COM, or .BAT.  Filefind§ uses the windows 
WIN.INI [windows] programs variable to determine whether a file 
is executable.  For example, you may wish to run PIF files.  The 
programs entry should then look something like:

programs=com exe bat PIF
For more information, consult your windows manual.

Example:

you might want to define the Run2 menu item to invoke the windows notepad.  
The entry will look something like:

You may also wish to add to or change the associations defined to windows.  These 
associations are used by Filefind§ when you choose Selection under the Action menu and
Filefind§ can not run the selection.  If Filefind§ can not run the selection directly, it looks
for the file's extension in the [Extensions] section of the WIN.INI.  If Filefind§ can find 
the extension, it invokes the program specified passing the selection as a parameter. 

The [Extensions] section contains entries that appear as:

txt=notepad.exe ^.txt
where txt is the extension and notepad.exe ^.txt is run by Filefind§ after substituting the 
selection for ^.txt with the selection.

Simply edit the WIN.INI as described above to add any additional associations desired.
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Usage

Filefind§ is invoked like other windows programs.

1. From the MS-DOS Executive, click on FILEFIND§.EXE, the File menu, and the 
Run menu item.

2. Double click on FILEFIND§.EXE.

3. Select Filefind§ from the Filefind§ Run menu.

Modes of Operation.

Filefind§ operates in one of two basic modes.  In file list mode, Filefind§ displays a list 
of files based on a search specification.  You may select files in the list and then copy 
them, delete them, etc.

In directory list mode, Filefind§ displays a directory tree of the requested disk drive.  You
may select one or more displayed directories, and instruct Filefind§ to switch into file list 
mode for that directory.  Filefind§ allows you to list all files in the selected directory or 
all files that match the current search specification that reside in the selected directory.

Filefind§ may be started in either one of these modes depending on how you set the 
initialization options in the default dialog.

You can also set Filefind§ to not automatically start in either mode.  If you do this, you 
will have to specifically request a file list or directory tree.

File List Mode.

File list mode presents you with a list of files.  You can also display file dates, 
times, attributes and sizes.  In this mode, you can select one or more files to copy, 
print, run, etc.

There are several ways to enter file list mode.  You can set the default startup to 
invoke the Filespec dialog when Filefind§ is started.  You can also invoke the 
Filespec dialog from the main menu at any time.  This dialog will allow you to 
enter a search specification and set the disk drive to search on.

You can also enter the file list mode from the directory list mode.  When you 
invoke file list mode from the directory mode, you will display a list of all the 
files in a selected directory(s) or all the files in the selected directory(s) that match
the current search specification.

Finally, if you are in the directory list mode and a file list is currently active, the 
main menu will contain a List menu item.  If you select this menu item, you will 
switch over to the current file list.
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Directory List Mode.

Directory list mode presents you with a tree of the current drive's directories.  You
can not do a whole lot in directory list mode except examine the organization of 
your disk's directory structure or invoke the file list mode for one or more specific
directories rather than all files on the disk.

Directory List mode can be entered in several ways.  You can set the default 
startup to invoke the Tree dialog when Filefind§ is started, or you can press the 
Bld Tree button in the Search dialog.  You may also select the Tree menu item in 
the Select menu at any time.

Finally, if you are in the file list mode, the main menu will contain a Tree menu.  
If you select this menu item, you will switch over to the directory tree.

If one or more directories in the tree are selected, you can choose the List 
Directory or the List Directory w/Spec items under the Select menu.  List 
Directory will invoke the file list mode and display all files in the selected 
directories.  You may also double click on the desired directory to select it and 
invoke the file list mode.  List Directory w/Spec will invoke the file list mode and 
display all files in the selected directories that match the current search 
specification.  

Mouse Usage

Filefind§ uses the mouse pretty much the same way as all other windows 
programs.  You can size, move, scroll, minimize, restore, maximize, ad nauseam.

The only special Filefind§ mouse functions are in the selection process.

When you are in the directory list mode, you can double click on a directory and 
switch to file list mode with a display of all the files in that directory.

When you are in the file list mode, you may select some or all the files in the list.  
Many of the other functions require that you select one or more of the files found.
Filefind§ recognizes two different selections.  The current selection is generally 
the last file that has been clicked on (delete, move, and copy functions can alter 
this).  A selection list is a list of all currently selected files including the current 
selection.  Files in the current selection list are displayed by Filefind§ in reverse 
video (white letters on black if you are using the default colors).  The current 
selection is further identified by a dotted rectangle around the displayed file.

All selections are made using the left mouse button.  To select a file, simply click 
in the desired file's display line.  If you click on another file, Filefind§ deselects 
the first file and selects the second file.  To deselect the current selection click on 
the selection.  If you deselect the current selection, you will not have a current 
selection.
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To select multiple files, first click on one of the desired files.  Then, while holding
the <Ctrl> key down, click on the rest of the files desired for the selection list.  
Pressing the <Ctrl> key tells Filefind§ to retain the current selections.

To select file ranges, first click on the file at either end of the range.  Then, while 
holding the <Shift> key down, click on the file at the other end of the range.  
Pressing the <Shift> key tells Filefind§ to select all files in the list from the 
current selection to the file being clicked on.

You may mix multiple file selection with range selection.  Just press the 
appropriate key before you click on the next file.  If you are pressing the <Ctrl> 
key, you will select an additional file.  If you are additionally pressing the <Shift>
key, you will extend the range from the current selection to the newly selected 
file.  You will retain all files in the current selection list until you click on a file 
when you are not holding down either the <Ctrl> key, or you deselect the files.

When you have a selection list active, you may deselect individual files in the list 
by clicking on the highlighted file while pressing the <Ctrl> key.

You may scroll through the file list and Filefind§ will maintain the current 
selection or list until you select another file or deselect all files.
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Menus

Filefind§ contains the following high level menu:

Select Edit View List Search Action Options

This section describes the contents of these menus.  Italic text describes menus and menu 
items.  Italic underlined characters denote accelerator keys.

Select Select contains menu items that allow you to select different file 
lists, search drives, or directory trees.  Additionally, as the first 
menu item, Select contains the About... dialog and Exit command.

Build Tree... Build Tree allows you display a directory 
tree for a new disk drive.

List Dir(s) List Dir(s)splays all files for the selected 
directories in the tree.

List Dir(s) w/spec List Dir(s) w/spec, displays all files for the 
selected directory in the tree that match the 
current search specification.

Exit quits the Filefind§ program.

About... displays a dialog box containing version, 
copyright, file counts and directory counts 
for the current search.

Edit The Edit menu enables a displayed file list or selection list to be 
copied to the clipboard.

Copy List copies the entire file list to the clipboard.  
The list is copied as shown.  File attributes 
such as date and size are written to the 
clipboard if they are currently being show.

Copy Selections copies files in the current selection list to the
clipboard.  As above, whichever attributes 
are currently showing are copied to the 
clipboard also.

View The View menu determines what is displayed in the Filefind§ 
window and how the items are displayed.

Date is a toggle.  When checked, the each file's 
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date is displayed.  When unchecked, it is not.
This item is only available in file list mode

Time is a toggle.  When checked, the file's time is 
displayed.  When unchecked, it is not.  This 
item is only available in file list mode.

Size is a toggle.  When checked, the file's size is 
displayed.  When unchecked, it is not.  This 
item is only available in file list mode.

Attribute is a toggle.  When checked, the file's 
attributes are displayed.  When unchecked, 
they are not.  The attribute appears as 
rxdahsv where:

rx is 'rw' for a read-write file or 'ro' for a read-
only file;

d is 'd' if the file is a directory, space if not;

a is 'a' if the archive bit has been set, space if it
has not;

h is 'h' if the file is a hidden file, space if it is 
not;

s is 's' if the file is a system file, space if it is 
not;

v is 'v' if entry is a system volume id, space if 
it is not.

This item is only available in file list mode.

Concatenate Path
Separate Path 

Concatenate Path causes the file name and file path to appear as one long string.  Separate Path 
causes the file name and file path to appear as two strings in separate columns.  These two items 
act as a toggle.  This item is only available in file list mode.

Unsorted displays the files (or directories) as they 
were found.  This item is available in both 
file list and directory list modes.

by Name displays the files in filename (or directory 
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name) order.  The sort actually sorts 
filename then file extension so that x.a is 
guaranteed to appear before x.b.  For the 
directory tree  display, subdirectories in a 
directory are sorted with each other and 
separately from subdirectories in another 
directory.  This option is available in both 
file list and directory tree modes.

by Kind displays the files in file extension order.  The
sort actually sorts on the file extension and 
then the file name so that a.a is guaranteed to
appear before b.a.  This option is only 
available in file list mode.

by Date/Time displays the files in the order that they were 
created.  The sort is a two part sort.  The full
date is the high order part of the sort key and
the time, the low part of the sort key.  This 
option is only available in file list mode.

by Size displays the files according to their size.  
The only option is an ascending sort with the
smallest file appearing at the top of the 
window and the largest file at the bottom of 
the window.  This option is only available in
file list mode.
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List
Tree

List and Tree are alternating menu Ids.  When Filefind§ is in directory list mode, List will appear 
and clicking on it will toggle you into file list mode.  Likewise, if you are in file list mode, Tree 
is the displayed menu Id, and selecting it will toggle you into directory list mode.

 Search allows you enter the file specification for Filefind§ to search on.  
When Filespec is chosen, a dialog that allows search pattern 
specification and disk drive selection is presented.

Action contains menu items pertaining to actions that can be taken with 
entire selection lists.

Delete Selections... allows you to delete all or some of the files 
in the current selection list.

Print Selections... allows you to print all or some of the files in 
the current selection list.

Copy Selections... allows you to copy all or some of the files in 
the current selection list to a different 
directory on the same disk or a directory on 
a different disk.

Move Selections... allows you to move all or some of the files 
in the current selection list to a different 
directory on the same disk or a directory on 
a different disk.  Move actually performs a 
copy to the destination and then erases the 
source file.

Selection attempts to run the current selection.  The 
file extension must be a program as defined 
in the WIN.INI file.  If the selection is not an
executable, the extensions in the WIN.INI 
are checked for an associated program which
is invoked using the selection as a parameter.

FileFind runs another copy of Filefind§.
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The rest of this menu consists of user defined menu items.  Each of
these will run the program defined for the menu item.  The 
currently selected file concatenated to its drive and path will be 
passed as a command parameter.

Options

Options allows setting of defaults, options, initializations, etc.

Printer Setup... displays the dialog box for the current 
printer driver.  The contents of this and the 
user interactions are device dependent.

Set Defaults... allows the setting of most initialization and 
default options.  See the WIN.INI appendix 
and the installation section for further 
information on options that can not set 
within this dialog.

Set Options to Defaults

Register License invokes the registration dialog box.  Once
Filefind§ is registered, the supplied license 
id is entered through this dialog.
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Dialogs

This sections describes the various dialogs presented by Filefind§.  These dialogs are 
presented alphabetically according to the invoking menu item.

About... displays version, copyright, etc. information.  The current 
drive, number of directories, number of files, and the total 
size of the listed files are also displayed.  An OK push-
button is provided to exit the dialog.

Copy Selections... copies all or part of the current selection list to a new disk\
directory.  Two dialog boxes are used.  The first dialog 
allows you to specify the destination drive and directory.  
Double click the list box in this dialog until the drive and 
directory are satisfactory.  Click on the OK push button to 
proceed.  If you wish to abort the copy operation, click on 
the Cancel push-button.  The second dialog displays a list 
of the selected files.  Below the list is the file that is about 
to be processed.  Click the OK push-button to copy the file, 
Ignore push-button to bypass copying this one file, and 
Cancel to bypass all the remaining files.  There is also a 
check box that allows you to bypass clicking on the OK 
push button for each file.  If you un-check this box, all 
remaining files in the selection list will be copied without 
further intervention.  Be aware that if you do this, you will 
have no opportunity to intervene or stop the process once 
the automatic operation has started.

If directories or volume entries are in the selection list, a 
message will be displayed and they will be left uncopied.

Delete Selections... deletes all or part of the current selection list.  The dialog 
displays a list of the selected files.  Below the list is the file 
about to be deleted.  Click the OK push-button to delete the 
file, Ignore push-button to bypass deleting this one file, and
Cancel to bypass all the remaining files.  There is also a 
check box that allows you to bypass clicking on the OK 
push button for each file.  If you un-check this box, all 
remaining files in the selection list will be deleted without 
further intervention.  Be very aware that if you do this, you 
will have no opportunity to intervene or stop the process 
once the automatic operation has started.

If directories are in the selection list, they will be deleted if 
they are empty (contain no files or subdirectories).  Volume
Id entries in the selection list will cause a message to be 
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displayed and the entry left un-deleted.  The dialog displays
a list of the selected files.  Below the list is the file about to 
be deleted.  Click the OK push-button to delete the file, 
Ignore push-button to bypass deleting this one file, and 
Cancel to bypass all the remaining files.  There is also a 
check box that allows you to bypass clicking on the OK 
push button for each file.  If you un-check this box, all 
remaining files in the selection list will be deleted without 
further intervention.  Be very aware that if you do this, you 
will have no opportunity to intervene or stop the process 
once the automatic operation has started.

If directories are in the selection list, they will be deleted if 
they are empty (contain no files or subdirectories).  Volume
Id entries in the selection list will cause a message to be 
displayed and the entry left un-deleted.

Move Selections... moves all or part of the current selection list to a new disk\
directory.  Two dialog boxes are used.  The first dialog 
encountered allows you to specify the destination drive and 
directory.  Double click in the list box until the drive and 
directory are satisfactory.  Click on the OK push button to 
continue.  If you wish to abort the move operation, click on 
the Cancel push-button.  The second dialog displays a list 
of the selected files.  Below the list is the file about to be 
moved.  Click the OK push-button to move the file, Ignore 
push-button to bypass moving this one file, and Cancel to 
bypass all the remaining files.  There is also a check box 
that allows you to bypass clicking on the OK push button 
for each file.  If you un-check this box, all remaining files 
in the selection list will be copied without further 
intervention.  Be aware that if you do this, you will have no
opportunity to intervene or stop the process once the 
automatic operation has started.

If a directory or volume id entry is in the selection list, a 
message is displayed, and the entry left unmoved.

Print Selections... prints all or part of the current selection list.  The dialog 
displays a list of the selected files.  Below the list is the file 
that will be printed next.  Click the OK push-button to print
the file, Ignore push-button to bypass printing this one file, 
and Cancel to bypass all the remaining files.  There is also a
check box that allows you bypass clicking on the OK push 
button for each file.  If you un-check this box, all remaining
files in the selection list will be printed without further 
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intervention.  Be aware that if you do this, you will have no
opportunity to intervene or stop the process once the 
automatic operation has started. 

If directory or volume id entry is in the selection list, it can 
not be printed.

Printer Setup... invokes the dialog to set up the currently selected printer.  
This dialog is device dependent and is the same dialog that 
you see when you select a printer from the Control program
supplied with your Windows software.

Register License... Invokes a simple edit dialog box.  This box allows you to 
type in the license id that you receive when you register 
your copy of Filefind§.  The case of letters is not important.
Clicking the OK box causes Filefind§ to validate and store 
the id.  If it is valid, it will be stored in the WIN.INI file 
and you will exit the dialog.  If it is invalid, a message will 
be displayed, and you are left in the dialog.  You may click 
on Cancel to leave the dialog.  Filefind§ will not store an 
invalid license id.  Once you have entered your valid 
license id, there is no point in ever invoking this dialog 
again.

Search The Search dialog is where you enter the file specification 
used for the search or building a directory tree.  You also 
specify which drive to search on in this dialog box.  When 
the file and drive specification are satisfactory, you can take
one of the following actions:

Search Will search the selected disk drive for all 
files that match the file specifications.

Bld Tree Will build a directory tree.
Set Sets the current file specification, exits the 

dialog, but does not search for any files or 
build a directory tree.  This is useful when 
you have a directory tree and wish to change
what files List Dir(s) w/spec will list.

Cancel Exits the dialog without doing anything.
More >> Expands the dialog for additional file search 

filtering based on file attribute or file date.

If .EXT Directories is checked, FileFind§ will include 
directories with extensions in the tree building, otherwise 
directories with extensions are ignored.  Check this option 
if you have directories with extensions.  Otherwise, leave it 
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unchecked as FileFind§ will build the directory tree up to 
twice as fast.
The More>> button will display additional filtering of files 
during search opertaions.  Checkboxes for file attributes 
allow you to include certain file types.  Normal files are 
always included.  By checking one or more of the options, 
you may include other file attributes in the file list.  For 
example, checking Read Only will include read only files in
addition to normal files.

Checking the Within box opens the edit field to its right.  
When Within is checked, Filefind§ will only include files 
with file dates within n days of the current date.

The More>> button turns into a <<Less button which 
allows you to shrink the dialog box again.  Once the file 
specification and drive are set, they will remain in effect 
until you change them or exit Filefind§.  See the Set 
Defaults... dialog for initializing the disk drive.  The initial 
search specification is always *.*.

Set Defaults... Allows you to set most of the initial values and display 
options that Filefind§ will use when you run it.  Check 
boxes are used for:

Display Date

Display Time

Display Size

Display Attributes

Concatenate Path

If the first four display boxes are checked, they will be 
initialized to be displayed.  If the concatenate path is 
checked, the filename will be initially concatenated to its 
path and displayed in one large column.

The initial drive scroll bar allows you to specify the default 
drive that appears in the Filespec... dialog the first time it is
invoked.  You may set this to any valid drive on your 
system. You may also set it to default drive.  In this 
setting, the default drive is the drive that you are on when
Filefind§ is first invoked.

The attribute checkboxes and radio buttons allow you to set 
a default set of filters.  These defaults can be changed later 
in the Search dialog.
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The File Spec box at startup radio button controls whether 
or not the Filespec... dialog is automatically invoked when 
you start Filefind§.  If you set the File Spec at startup 
button, the Directory Tree at startup box will be reset.

The Directory Tree at startup radio button controls whether 
or not the Tree... dialog is automatically invoked when you 
start Filefind§.  If you set the Directory Tree at startup 
radio button, the File Spec box at startup will be reset.  

Save Window Size always appears unchecked in the dialog 
when it is invoked.  If you check it, the current size will be 
saved if the OK push-button is clicked. The next time you 
invoke Filefind§, its window will initially be this saved 
size.

Tree ... Invokes the dialog that allows you to change the current 
drive.  This dialog builds a list of the selected drive's 
directories and displays the tree.
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Support

Technical assistance is available via Compuserve, Easyplex 74076,1632.  Support will be 
cheerfully provided for registered users.  You may also write to the same address as you 
sent your registration, but presumably, you would rather have a quicker response, so you 
will probably want to use Compuserve.

Any bug reports, while not welcome, will none the less be appreciated.  Please send any to 
the registration address or through Compuserve.

WIN.INI formats

Filefind§ maintains its default settings and other variable information in the WIN.INI file.
This section describes these variables.  Most of Filefind§ settings are in the [SRS File 
Finder] section.

The variables are:

Date Display If 1, the file date is initially displayed.  If 0, the file date is not 
initially displayed.

Time Display If 1, the file time is initially displayed.  If 0, the file date is not 
initially displayed.

Size Display If 1, the file size is initially displayed.  If 0, the file size is not 
initially displayed.

Attribute Display If 1, the file attributes are initially displayed.  If 0, the file 
attributes are not initially displayed.

Concatenate Path If 1, the initial display shows the file name and path concatenated.  
If 0, the initial display shows the file name and path in separate 
columns.

Drive If null (i.e. "DRIVE="), the initial disk drive in the filespec dialog 
is the current working directory.  Otherwise, Filefind§ uses the 
initial disk letter (e.g. 'C' for drive 'C', etc.).

Winx defines the initial horizontal size of the window.

Winy defines the initial vertical size of the window.

initial dir tree If 1, Filefind§ will automatically invoke the Tree dialog at startup. 
If 0, you will have to invoke the Tree dialog specifically.

initial filespec If 1, Filefind§ will automatically invoke the filespec dialog at 
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startup.  If 0, you will have to invoke the filespec dialog 
specifically.

Run2-9 defines user defined menu items.  The programs variable in 
[windows] defines the file extensions that Filefind§ considers to be
executable files.

Registration Your registration identification.

lAttr defines what attribute filters Filefind§ will default to.  It consists of
a string of eight zeroes or ones.

Messages

This appendix documents the various messages produced by Filefind§. 
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Can not copy a Subdirectory

A subdirectory is in the selection list and you have invoked the copy command. 
Filefind§ can not copy subdirectories.

Can not copy a Volume Id

A volume label is in the selection list and you have invoked the copy command. 
Filefind§ can not copy volume labels.

Can not delete Volume Id

A volume label is in the selection list and you have invoked the delete command. 
Filefind§ can not delete volume labels.

Can not move a Subdirectory

A subdirectory is in the selection list and you have invoked the move command. 
Filefind§ can not move subdirectories.

Can not move a Volume Id

A volume label is in the selection list and you have invoked the move command. 
Filefind§ can not move volume labels.

Can not move to the same directory

An attempt to copy or move a file to the same directory has been made.

Can not run menu item xxxx

You have attempted to invoke a user defined menu item.  xxxx is the associated 
program id.  Filefind§ does not consider the associated program id to be an 
executable file.  If the associated program id is an executable file, your win.ini file
may be in error.  See the section on installing Filefind§ for further information.

Can not run selection xxxx

You have attempted to invoke a selection that Filefind§ does not consider an 
executable file.  xxxx is the associated program id.  If you have selected what you 
think is an executable file, your win.ini file may be in error.  See the section on 
installing Filefind§ for further information.

A Directory is not Currently Selected.

The list directory or list directory w/spec menu item has been invoked.  However, 
you have not yet selected a directory tree item.
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Do not ignore these messages.

You are running an unlicensed copy of Filefind§ and clicked on the Ignore button.
You can not ignore these messages.  You should also license you copy of
Filefind§.

- Error S1002 - File Limit Exceeded

Some versions of Filefind§ have a built-in limit to the number of files that may be
found.  

File not found

No files matching the entered file specification were found.  Check the 
specification.  Also make sure that you specified the correct disk drive.

No files selected

A delete, move, print, or one of the user defined menu items has been requested, 
but no file has been selected.

No files to show

Filefind§ could not find any files to show.  This may come from a file search, 
trying to list files in an empty directory, etc.

Not a valid license Id

You have entered the license registration id and clicked the OK but the id is 
invalid.  Correct and re-try.

Not enough memory to construct selection string

Not enough memory exists construct a string of the selections.  Free some 
memory by closing existing applications.

Not enough memory to continue

Filefind§ needs to allocate memory and there isn't enough available.  This can 
occur while Filefind§ is searching the disk and building lists of directories and 
matching files, when copying a file, or moving a file.  Freeing up memory from 
other windows applications may help.  If this happens while Filefind§ is building 
the file list based on a search specification, you probably have hundreds of files 
that match the search specification.  Try narrowing the search specification.

Not enough memory to create destination path
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An attempt to copy or move a file is being made.  Not enough memory exists to 
create destination directory information.  

Overwrite xxxx 

A copy operation has been specified and the file already exists in the destination 
directory.  If you want to write over the existing file, click on OK.  Click on 
Cancel to leave the existing file in the destination directory intact.

Unable to delete Directory filename.ext

Filefind§ is unable to delete the directory filename.ext.  The most likely cause is 
that the subdirectory contains other subdirectories or files.  Filefind§ can only 
delete empty subdirectories.  Another reason may be that it is a read-only file.

Unable to delete File filename.ext

Filefind§ is unable to delete the file filename.ext.  The most likely cause is that 
the file is a read-only file.

Within days are invalid

The days to use for the Within filter is invalid.  This value must be a positive 
number

xxxx opening destination file

A DOS error has occurred trying to open the destination file for a copy or move.  
xxxx is the DOS error code.

xxxx opening source file

A DOS error has occurred trying to open the source file for a copy, move, or 
print. xxxx is the DOS error code. 

xxxx reading source file

A DOS error has occurred trying to read the source file for a copy or move.  xxxx 
is the DOS error code.

xxxx writing destination file

A DOS error has occurred trying to write the destination file for a copy or move.  
xxxx is the DOS error code.
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License Information

Filefind§ is distributed as a shareware product.  All rights have been reserved by the 
author.  Filefind§ has not been released into the public domain.  If you use Filefind§ 
beyond an initial evaluation period, you must purchase a license.  Two license options are
available. You may purchase one license for each user of Filefind§.  Alternatively, you 
may purchase a site license.

Duplication and Distribution Restrictions

Filefind§ is a shareware product.  It may be copied and distributed for others to 
evaluate as long as the following rules are followed.  They are:

1) The Filefind§ program, this documentation, and any other accompanying 
materials may not be modified in any way.

2) A copy of this documentation and all accompanying materials must be 
distributed along with the program.

3) You may not charge for distributing this program, except  for a nominal 
media and handling charge. In any case, such a charge may not exceed 
$5.00.

4) Users of Filefind§ must purchase a license for its use.  One license per 
copy of Filefind§, or the alternative site license, is required.  Note that this 
requirement allows you to make as many backup copies as you wish as 
long as you have a license per user or a site license.

5) If you purchased a disk containing this software from a public 
domain/shareware software distributor, you have paid the media and 
handling charges as permitted in 3 above.  You have not purchased the 
required license for Filefind§.  Purchasing a license is required for 
continued use.
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Rates

Two rate scales are available for licensing Filefind§. You may purchase a single 
user license or a site license. For either, you may simply purchase a license, or 
you may purchase a license, the current version on disk, and/or a printed copy of 
the documentation.

Refer to the license applications following this section for current rates.

The purchase of a license allows you to use Filefind§ and receive support.  As 
new versions are released, you may obtain them through the various shareware 
channels.  New versions will also be available directly from the author for a 
nominal materials and shipping charge.

Make checks payable to and send payments to:

William L. Page

P.O. Box 266

Flagtown, New Jersey 08821-0266

Note Payments must be US funds.  Checks must be drawn on or payable 
through a US bank.  If you wish to remit a foreign check, we will attempt 
to have our bank process it through their collection department if you 
include a $7 fee.  Somehow that doesn't seem worth it.  Foreign users are 
probably better off sending cash.
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µApplication for Single User License Registration
FileFind§  3.3§

Date: ____________________________

To: William L. Page

P.O. Box 266

Flagtown, New Jersey 08821-0266

Please register Filefind§ for:

Name______________________________________________________________

(Company)_________________________________________________________

(Title)_____________________________________________________________

Address____________________________________________________________

City, State Zip   _____________________________________________________

Windows version that I am currently using: _______________________________

I got Filefind§ from (BBS & Phone #) ___________________________________

___________________________________________________________________

+--------------------------------+--------+-------+---------+
|  Item                          | Unit $ | Quant | Total $ |
+--------------------------------+--------+-------+---------+
|  FileFind                      |    $12 |       |         |
+--------------------------------+--------+-------+---------+
|  Current Version on 5 1/4 disk |     $6 |       |         |
+--------------------------------+--------+-------+---------+
|  Current Version on 3 1/2 disk |     $6 |       |         |
+--------------------------------+--------+-------+---------+
|  Printed Documentation         |     $9 |       |         |
+--------------------------------+--------+-------+---------+
|         Total                                   |         |
+-------------------------------------------------+---------+

§
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µApplication for Site License Registration
FileFind§  3.3§

Date: ____________________________

To: William L. Page

P.O. Box 266

Flagtown, New Jersey 08821-0266

Please register Filefind§ for:

Name______________________________________________________________

(Company)_________________________________________________________

(Title)_____________________________________________________________

Address____________________________________________________________

City, State Zip_______________________________________________________

Windows version that I am currently using: _______________________________

I got Filefind§ from (BBS & Phone #) ___________________________________

___________________________________________________________________

+--------------------------------+--------+-------+---------+
|  Item                          | Unit $ | Quant | Total $ |
+--------------------------------+--------+-------+---------+
|  First 10 Users                |   $100 |     1 |    $100 |
+--------------------------------+--------+-------+---------+
|  Users 11-20                   |     $9 |       |         |
+--------------------------------+--------+-------+---------+
|  Users 21-50                   |     $8 |       |         |
+--------------------------------+--------+-------+---------+
|  Users 50+                     |     $7 |       |         |
+--------------------------------+--------+-------+---------+
|  Current Version on 5 1/4 disk |    $12 |       |         |
+--------------------------------+--------+-------+---------+
|  Current Version on 3 1/2 disk |    $12 |       |         |
+--------------------------------+--------+-------+---------+
|  Printed Documentation         |    $12 |       |         |
+--------------------------------+--------+-------+---------+
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|         Total                                   |         |
+-------------------------------------------------+---------+

§
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